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1.  INTRODUCTION

The RCM3305 and RCM3315 RabbitCore modules feature a

compact module that incorporates the latest revision of the power-

ful Rabbit® 3000 microprocessor, flash memory, mass storage

(serial flash), static RAM, and digital I/O ports. The RCM3305

and RCM3315 feature an integrated 10/100Base-T Ethernet port,

and provide for LAN and Internet-enabled systems to be built as

easily as serial-communication systems.

In addition to the features already mentioned above, the RCM3305 and RCM3315 have 

two clocks (main oscillator and real-time clock), reset circuitry, and the circuitry necessary 

for management of battery backup of the Rabbit 3000’s internal real-time clock and the 

static RAM. Two 34-pin headers bring out the Rabbit 3000 I/O bus lines, parallel ports, 

and serial ports.

The RCM3305’s and the RCM3315’s mass-storage capabilities make them suited to running 

the optional Dynamic C FAT file system module and the featured remote application 

update where data are stored and handled using the same directory file structure com-

monly used on PCs.

The RCM3305 or RCM3315 receives +3.3 V power from the customer-supplied mother-

board on which it is mounted. The RCM3305 and RCM3315 can interface with all kinds 

of CMOS-compatible digital devices through the motherboard.

The Development Kit has what you need to design your own microprocessor-based 

system: a complete Dynamic C software development system and a Prototyping Board 

that allows you to evaluate the RCM3305 or RCM3315, and to prototype circuits that 

interface to the RCM3305 or RCM3315 module.
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1.1  RCM3305/RCM3315 Features

• Small size: 1.85" x 2.73" x 0.86"

(47 mm x 69 mm x 22 mm) 

• Microprocessor: Rabbit 3000 running at 44.2 MHz

• 49 parallel 5 V tolerant I/O lines: 43 configurable for I/O, 3 fixed inputs, 3 fixed outputs

• Three additional digital inputs, two additional digital outputs

• External reset

• Alternate I/O bus can be configured for 8 data lines and 6 address lines (shared with 

parallel I/O lines), plus I/O read/write

• Ten 8-bit timers (six cascadable) and one 10-bit timer with two match registers 

• 512K flash memory, 512K program execution SRAM, 512K data SRAM

• Serial-flash mass-storage memory options, which are required to run the optional 

Dynamic C FAT file system module and the featured remote application update.

• Real-time clock

• Watchdog supervisor

• Provision for customer-supplied backup battery via connections on header J4

• 10-bit free-running PWM counter and four pulse-width registers

• Two-channel Input Capture (shared with parallel I/O ports) can be used to time input 

signals from various port pins

• Two-channel Quadrature Decoder accepts inputs from external incremental encoder 

modules

• Five or six 3.3 V CMOS-compatible serial ports with a maximum asynchronous baud 

rate of 5.525 Mbps. Three ports are configurable as a clocked serial port (SPI), and two 

ports are configurable as SDLC/HDLC serial ports (shared with parallel I/O ports).

• Supports 1.15 Mbps IrDA transceiver

The RCM3900/RCM3910 and RCM3365/RCM3375 RabbitCore modules are similar to 

the RCM3305/RCM3315 and RCM3309/RCM3319, but they use fixed NAND or remov-

able media for their mass-storage memories instead of the fixed serial flash options of the 

RCM3305/RCM3315 and the RCM3309/RCM3319.
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Table 1 below summarizes the main features of the RCM3305 and the RCM3315 modules.

The RCM3305 and RCM3315 are programmed over a standard PC serial port through a 

programming cable supplied with the Development Kit, and can also be programed through 

a USB port with an RS-232/USB converter, or directly over an Ethernet link using the fea-

tured remote application update or the Dynamic C download manager with or without a 

RabbitLink.

Appendix A provides detailed specifications for the RCM3305 and the RCM3315.

Table 1.  RCM3305/RCM3315 Features

Feature RCM3305 RCM3315

Microprocessor Rabbit 3000 running at 44.2 MHz

SRAM 512K program (fast SRAM) + 512K data

Flash Memory 

(program)
512K

Flash Memory

(mass data 

storage)

8 Mbytes

(serial flash)

4 Mbytes

(serial flash)

Serial Ports

5 shared high-speed, 3.3 V CMOS-compatible ports:

all 5 are configurable as asynchronous serial ports;

3 are configurable as a clocked serial port (SPI) and 1 is 

configurable as an HDLC serial port;

option for second HDLC serial port at the expense of 2 

clocked serial ports (SPI)
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1.2  Comparing the RCM3309/RCM3319 and RCM3305/RCM3315

We can no longer obtain certain components for the RCM3305/RCM3315 RabbitCore 

modules that support the originally specified -40°C to +70°C temperature range. Instead of 

changing the design of the RCM3305/RCM3315 RabbitCore modules to handle available 

components specified for the original temperature range, we decided to develop a new 

product line — the RCM3309/RCM3319 — based on the RCM3900 RabbitCore modules 

that were released for the same reason.

The RCM3309/RCM3319 modules are similar in form, dimensions, and function to the 

RCM3305/RCM3315 modules. We strongly recommend that existing RCM3305/3315 

customers and designers of new systems consider using the new RCM3309/RCM3319 

RabbitCore modules.

This section compares the two lines of RabbitCore modules.

• Temperature Specifications — RCM3305/RCM3315 RabbitCore modules manufac-

tured after May, 2008, are specified to operate at 0°C to +70°C. The RCM3309/

RCM3319, rated for -40°C to +85°C, are offered to customers requiring a larger 

temperature range after May, 2008.

• Maximum Current — The RCM3305/RCM3315 draws 250 mA vs. the 325 mA 

required by the RCM3309/RCM3319.

• LEDs — The SPEED and user (USR/BSY)LED locations have been swapped between 

the RCM3305/RCM3315 and the RCM3309/RCM3319, the LNK/ACT LEDs have 

been combined to one LED on the RCM3309/RCM3319, and the RCM3309/RCM3319 

has an FDX/COL LED instead of the SF LED on the RCM3305/RCM3315. The SF 

LED on the RCM3305/RCM3315 blinks when data are being written to or read from 

the serial flash. The FDX/COL LED on the RCM3309/RCM3319 indicates whether the 

Ethernet connection is in full-duplex mode (steady on) or that a half-duplex connection 

is experiencing collisions (blinks).

NOTE: The change in LED indicators means that there is no indication on the 

RCM3309/RCM3319 when data are being written to or read from the serial flash.

• Ethernet chip. A different Ethernet controller chip is used on the RCM3309/RCM3319. 

The Ethernet chip is able to detect automatically whether a crossover cable or a straight-

through cable is being used in a particular setup, and will configure the signals on the 

Ethernet jack interface.

• Dynamic C — As long as no low-level FAT file system calls were used in your applica-

tion developed for the RCM3305/RCM3315, you may run that application on the 

RCM3309/RCM3319 after you recompile it using Dynamic C v. 9.60.
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1.3  Advantages of the RCM3305 and RCM3315

• Fast time to market using a fully engineered, “ready-to-run/ready-to-program” micro-

processor core.

• Competitive pricing when compared with the alternative of purchasing and assembling 

individual components.

• Easy C-language program development and debugging

• Program download utility (Rabbit Field Utility) and cloning board options for rapid 

production loading of programs.

• Generous memory size allows large programs with tens of thousands of lines of code, 

and substantial data storage.

• Integrated Ethernet port for network connectivity, with royalty-free TCP/IP software.

• Ideal for network-enabling security and access systems, home automation, HVAC 

systems, and industrial controls
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1.4  Development and Evaluation Tools

1.4.1  RCM3305 Series Development Kit

The RCM3305 Series Development Kit contains the hardware you need to use your 

RCM3305 or RCM3315 module.

• RCM3309 module.

• Prototyping Board.

• Universal AC adapter, 12 V DC, 1 A (includes Canada/Japan/U.S., Australia/N.Z., U.K., 

and European style plugs).

• USB programming cable with 10-pin header.

• Dynamic C CD-ROM, with complete product documentation on disk.

• Getting Started instructions.

• Accessory parts for use on the Prototyping Board.

• Screwdriver and Cat. 5 Ethernet cables.

• Rabbit 3000 Processor Easy Reference poster.

• Registration card.

Figure 1.  RCM3305 Series Development Kit

����������	
���
��
�
������


�
������������	
�

����

�
���	
�
���


�
������������	
�

��
���
���


�
��
	�����

�	���

Rabbit, RabbitCore, Dynamic C, and Digi are registered trademarks of Digi International Inc.

RabbitCore® RCM3305 Series

The RCM3305 series of RabbitCore modules features built-in Ethernet, and onboard mass storage (serial 

flash). These Getting Started instructions included with the Development Kit will help you get your 

RCM3309 up and running so that you can run the sample programs to explore its capabilities and develop 

your own applications.

Development Kit Contents

The RCM3305 Series Development Kit contains the following items

• RCM3309 module.

• Prototyping Board.

• Universal AC adapter, 12 V DC, 1 A (includes Canada/Japan/U.S., Australia/N.Z., U.K., and 

European style plugs).

• USB programming cable with 10-pin header.

• Dynamic C® CD-ROM — with complete product documentation on disk.

• A bag of accessory parts for use on the Prototyping Board.

• Screwdriver and Cat. 5 Ethernet cables.

• Getting Started instructions.

• Rabbit 3000 Processor Easy Reference poster.

• Registration card.

Visit our online Rabbit store at www.rabbit.com/store/ for 

the latest information on peripherals and accessories that 

are available for the RCM3305 series of RabbitCore 

modules.

Installing Dynamic C®

Insert the CD from the Development Kit in 

your PC’s CD-ROM drive. If the installation 

does not auto-start, run the setup.exe pro-

gram in the root directory of the Dynamic C 

CD. Install any optional Dynamic C modules 

or packs after you install Dynamic C.
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1.4.2  Software

The RCM3305 and the RCM3315 are programmed using version 9.25 or later of Rabbit’s 

Dynamic C. A compatible version is included on the Development Kit CD-ROM. 

Dynamic C v. 9.60, which is required for the related RCM3309 and RCM3319 RabbitCore 

modules, includes the popular µC/OS-II real-time operating system, point-to-point proto-

col (PPP), FAT file system, RabbitWeb, and other select libraries that were previously sold 

as indidual Dynamic C modules.

Rabbit also offers for purchase the Rabbit Embedded Security Pack featuring the Secure 

Sockets Layer (SSL) and a specific Advanced Encryption Standard (AES) library. In addi-

tion to the Web-based technical support included at no extra charge, a one-year telephone-

based technical support subscription is also available for purchase. Visit our Web site at 

www.rabbit.com for further information and complete documentation, or contact your 

Rabbit sales representative or authorized distributor.

1.4.3  Connectivity Interface Kits

Rabbit has available a Connector Adapter Board.

• Connector Adapter Board (Part No. 151-0114)—allows you to plug the RCM3305/

RCM3315 whose headers have a 2 mm pitch into header sockets with a 0.1" pitch.

Visit our Web site at www.rabbit.com or contact your Rabbit sales representative or autho-

rized distributor for further information.

1.4.4  Online Documentation

The online documentation is installed along with Dynamic C, and an icon for the docu-

mentation menu is placed on the workstation’s desktop. Double-click this icon to reach the 

menu. If the icon is missing, use your browser to find and load default.htm in the docs 

folder, found in the Dynamic C installation folder.

The latest versions of all documents are always available for free, unregistered download 

from our Web sites as well.
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2.  GETTING STARTED

This chapter describes how to set up and use an RCM3305 series

module and the Prototyping Board included in the Development Kit.

NOTE: It is assumed that you have a Development Kit. If you purchased an RCM3305 

series module by itself, you will have to adapt the information in this chapter and else-

where to your test and development setup.

2.1  Install Dynamic C

To develop and debug programs for an RCM3305 series module (and for all other Rabbit 

hardware), you must install and use Dynamic C.

If you have not yet installed Dynamic C version 9.25 (or a later version), do so now by 

inserting the Dynamic C CD from the Development Kit in your PC’s CD-ROM drive. If 

autorun is enabled, the CD installation will begin automatically.

If autorun is disabled or the installation otherwise does not start, use the Windows 

Start | Run menu or Windows Disk Explorer to launch setup.exe from the root folder 

of the CD-ROM.

The installation program will guide you through the installation process. Most steps of the 

process are self-explanatory.

Dynamic C uses a COM (serial) port to communicate with the target development system. 

The installation allows you to choose the COM port that will be used. The default selec-

tion is COM1. You may select any available port for Dynamic C’s use. If you are not cer-

tain which port is available, select COM1. This selection can be changed later within 

Dynamic C.

NOTE: The installation utility does not check the selected COM port in any way. Speci-

fying a port in use by another device (mouse, modem, etc.) may lead to a message such 

as "could not open serial port" when Dynamic C is started.

Once your installation is complete, you will have up to three icons on your PC desktop. 

One icon is for Dynamic C, one opens the documentation menu, and the third is for the 

Rabbit Field Utility, a tool used to download precompiled software to a target system.

If you have purchased the optional Dynamic C Rabbit Embedded Security Pack, install it 

after installing Dynamic C. You must install the Rabbit Embedded Security Pack in the 

same directory where Dynamic C was installed.
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2.2  Hardware Connections

There are three steps to connecting the Prototyping Board for use with Dynamic C and the 

sample programs:

1. Attach the RCM3305 series RabbitCore module to the Prototyping Board.

2. Connect the programming cable between the RCM3305 series RabbitCore module and 

the workstation PC.

3. Connect the power supply to the Prototyping Board.

2.2.1  Step 1 — Attach Module to Prototyping Board

Turn the RCM3305 series module so that the Ethernet jack is facing the direction shown in 

Figure 2 below. Align the pins from the headers on the bottom side of the module into 

header sockets JA and JB on the Prototyping Board.

Figure 2.  Install the RCM3305/ Series Module on the Prototyping Board

NOTE: It is important that you line up the pins from the headers on the bottom side of the 

RCM3305 series module exactly with the corresponding pins of header sockets JA and 

JB on the Prototyping Board. The header pins may become bent or damaged if the pin 

alignment is offset, and the module will not work. Permanent electrical damage to the 

module may also result if a misaligned module is powered up.

Press the module’s pins firmly into the Prototyping Board header sockets—press down in 

the area above the header pins using your thumbs or fingers over the connectors as shown 

in Figure 2. Do not press down on the middle of the RCM3305 series module to avoid 

flexing the module, which could damage the module or the components on the module.

Should you need to remove the RCM3305 series module, grasp it with your fingers along the 

sides by the connectors and gently work the module up to pull the pins away from the sockets 

where they are installed. Do not remove the module by grasping it at the top and bottom.
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2.2.2  Step 2 — Connect Programming Cable

The programming cable connects the RCM3305 series module to the PC running 

Dynamic C to download programs and to monitor the module during debugging.

2.2.2.1  RCM3309 and RCM3319

Connect the 10-pin connector of the programming cable labeled PROG to header J1 on 

the RCM3309/RCM3319 as shown in Figure 3(a). There is a small dot on the circuit board 

next to pin 1 of header J1. Be sure to orient the marked (usually red) edge of the cable 

towards pin 1 of the connector. (Do not use the DIAG connector, which is used for a non-

programming serial connection.)

Figure 3(a).  Connect Programming Cable and Power Supply

Connect the other end of the programming cable to an available USB port on your PC or 

workstation. Your PC should recognize the new USB hardware, and the LEDs in the 

shrink-wrapped area of the USB programming cable will flash.

�
�
�
�
�

��
�

�
	


�

�
	


�

�
	





�
�



�
�



�
�

�
�



�



�








�

�������	�

�
�
��
�
�

�
�
�

�
�
�

�
�
�

�������
�



�


�
�
�

��� 

�
�

�
	
�
�
�

�
�
�
��

�
�
�
��

�
�
��
�
�
�
��

�
�
�
��

�
�

��

�	���
�
�����������



�

��
� � ��
� �

�
!

��
	
�

�
	


�

�
	


�

�
	


�

�
	


�

�
�



�
�

�
�



�



�



�



�

��
� �

 ��

�


�

�


�

�


�

�


�

�


�

�





�


�

�


�

 �


�
�
�

�
�
�

�
�
�

�
�
�

�
�



��
�

�
	
�
�
�
��

�
�
	



�
"

��
�#

��
�
�!

 ��

$��$��

���

�
�
�

�
�
����

���

���

�
	
�
��
�
�%
�
�
�
&
�

�
�


	
�

 �

�
�

�
�

�
�

�
�

�



�
�

��

�� $�

�
�
�

��

��


�

 �

 �

 �
 �

��
��������������������������������
!�
!��������
����
����
�����
 
!��'��
������������������!���!�������	����������������!��'

 �

��  �� ��  ��

��


��


!��

��	�

���


��
�

��


���

�	�

�	�

�	�

�%�

�%


���

��


���

���

 �

��

��"��!

!���

���
	�

����


���

���

�	�

�	�

�	


���

���

���


�������

�
%
�
��
�
%
�
��
�
	
�

�������

�����������

����


��
�	�	�

 �

�� ��

���

�
�

�
�

�



���

���

���

��


���

���

�%�

�%�

���

���

���

���

����

����

�
�

�
�

�
�

���

���

���

���

���

���

�%�

�%�

���

���

��


���

��


 �  �

��
��

�
�



�


�

�
�





�
�

��

��
�
�


�

��

��

�
�
�

 
�
�

���

�
� �

	
�

�
		

�
�
�

 
�
�

 ��

��� ���

��� �


���

�
�
�

$


���
��


�
�
�

���� �������������� ������
������� ����$�

�$�

��
���

$�

$�
����


&(
��!	�
����


&(
��!	�

$�

��
 ��� ��� ���

 ��
���

$��

���

�
�
�

��


���
 �


���

���

�
�
�

$�

���

 ��

�
�
�

�
�
� �

�
�

�
�
�

$)


$)�
����*

$)�
����*


)�

�
�



 ��

�
�

��

���


� 

 
� 
�

�
�
�

�
�
�

�
�
�

�
�
�

�
�
	

�
�
�

�
�
�

�
�
�

�
�
�

���	


�� 
�� 
�� 
�
 
�� �+	����+	�����
����+%����+%����
�����
����
'

�� �� �� ��

���

������������

���	���
$�	

��
�	��


$�

��
��


��"��!

�
�!

��"��!

�
�!

$�

$)�


)�

�)��

�)��

�)��

�)��

�)���)�


�%�,���


�%�,�


 ��

�
�

$�

�
�
�

�
�
�

�
�
�

�
�
�

�
�



�)�

�)�

�





�


�

�


�

�


�

�
�
�

�
�
�

�
�



�
�
�

�


�

�
�
�

������	�������

�


�

�


�

�
�
�
�
�
(�

�
�
�
�
�
(�

���

���

���

���

���������	

$�

�
�

��

��


�
�

 �

$�

�
�

��

 �� �

�

 �� �� �� �
 �

�

���


�
�

�
�

�
�

�
�

���

$�

�
�

$�

�
�

�
�
�

���
�

��
��$


���

���

�
�
�

�
�



�
�
�

���

�
�
�

 
�
�

 
�
�
�

 
�
�

 
�
�

��

 �

�
�
�

�
�
�

�
�
�

���

��

�
�



�
�
�

�
�
�

�
�
�

�
�
�

�
�
�

���

���

�
�



$�

�
�
�

���

�
�
�

���

��

���������

���
���

���

���
���

���

�
�
�

���
$�

���

���

�
�
�

�
�
�

���

���
��
���

�

�
�
�

� $
�

�
�
�

�
�
�

�


�

 
�
�
�

 
�
�
�

���
���

 
�
�
�

�
�
�

��

�
�
�

�
�
�

 ��� ���

$�

��

���

���

�
�
�

��
���
��

���

�
�


��


��

�
�
�

�
�
�

�
�
	



�
�

�
�
�



�
�

�
�


��

�
�
�

�����))


�

$��

��

�
�
�

�
�
�

�
�
�



��
�

�
�
�
�

�/./:97�9739

�
��
	�������	���

�
�
�
�

 
�

�/
���
���=/:5

�;19:5�5>?�2;5/�1./5

�:911�7/@;�/;�A.2=B
1;>=�=.C3�2;5/�=.>A9

�

�
�

�����
�����	���



����
����	���������	



12 RabbitCore RCM3305/RCM3315

2.2.2.2  RCM3305 and RCM3315

Connect the 10-pin connector of the programming cable labeled PROG to header J1 on 

the RCM3305/RCM3315 as shown in Figure 3(b). There is a small dot on the circuit 

board next to pin 1 of header J1. Be sure to orient the marked (usually red) edge of the 

cable towards pin 1 of the connector. (Do not use the DIAG connector, which is used for a 

nonprogramming serial connection.)

Figure 3(b).  Connect Programming Cable and Power Supply

NOTE: Be sure to use the serial programming cable (part number 101-0542)—the pro-

gramming cable has blue shrink wrap around the RS-232 converter section located in the 

middle of the cable. The USB programming cable and programming cables with clear or 

red shrink wrap from other Rabbit kits are not designed to work with RCM3305/

RCM3315 modules.

Connect the other end of the programming cable to a COM port on your PC.

NOTE: It may be possible to use an RS-232/USB converter with the serial programming 

described in this section. An RS-232/USB converter (part number 20-151-0178) is 

available through the Web store. Note that not all RS-232/USB converters work with 

Dynamic C.
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2.2.3  Step 3 — Connect Power

When all other connections have been made, you can connect power to the Prototyping 

Board.

If you have the universal power supply, prepare the AC adapter for the country where it 

will be used by selecting the plug. The RCM3305 Series Development Kit presently 

includes Canada/Japan/U.S., Australia/N.Z., U.K., and European style plugs. Snap in the 

top of the plug assembly into the slot at the top of the AC adapter as shown in Figure 3(a), 

then press down on the spring-loaded clip below the plug assembly to allow the plug 

assembly to click into place.

Depending on the style of adapter, connect the AC adapter to 3-pin header J2 or jack J1 on 

the Prototyping Board as shown in Figure 3(a) or Figure 3(b).

Plug in the AC adapter. The red CORE LED on the Prototyping Board should light up. 

The RCM3305 series RabbitCore module and the Prototyping Board are now ready to be 

used.

NOTE: A RESET button is provided on the Prototyping Board to allow a hardware reset 

without disconnecting power.

2.2.3.1  Alternate Power-Supply Connections

All Development Kits sold up to May, 2008, included a header connector that may be used 

to connect your power supply to 3-pin header J2 on the Prototyping Board. The connector 

may be attached either way as long as it is not offset to one side—the center pin of J2 is 

always connected to the positive terminal, and either edge pin is negative. The power 

supply should deliver 8 V to 30 V DC at 8 W.
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2.3  Starting Dynamic C

NOTE: Dynamic C v. 9.60 or a later version is required if you are using an RCM3309 or 

an RCM3319 RabbitCore module.

Once the RCM3305 series module is connected as described in the preceding pages, start 

Dynamic C by double-clicking on the Dynamic C icon on your desktop or in your Start 

menu. Select Code and BIOS in Flash, Run in RAM on the “Compiler” tab in the 

Dynamic C Options > Project Options menu. Click OK.

If you are using a USB port to connect your computer to the RCM3305/RCM3315 module, 

choose Options > Project Options and select “Use USB to Serial Converter” on the 

Communications tab. Click OK.

2.4  Run a Sample Program

Use the File menu to open the sample program PONG.C, which is in the Dynamic C 

SAMPLES folder. Press function key F9 to compile and run the program. The STDIO win-

dow will open on your PC and will display a small square bouncing around in a box.

This program shows that the CPU is working. The sample program described in 

Section 6.5, “Run the PINGME.C Sample Program,” tests the TCP/IP portion of the board.

2.4.1  Troubleshooting

If Dynamic C cannot find the target system (error message "No Rabbit Processor 
Detected."):

• Check that the RCM3305 series module is powered correctly — the red CORE LED on 

the Prototyping Board should be lit when the module is mounted on the Prototyping Board and 

the AC adapter is plugged in.

• Check both ends of the programming cable to ensure that they are firmly plugged into 

the PC and the PROG connector, not the DIAG connector, is plugged in to the program-

ming port on the RCM3305 series module with the marked (colored) edge of the pro-

gramming cable towards pin 1 of the programming header.

• Ensure that the RCM3305 series module is firmly and correctly installed in its connec-

tors on the Prototyping Board.

• Dynamic C uses the COM port or USB port specified during installation. Select a dif-

ferent COM port within Dynamic C. From the Options menu, select Project Options, 

then select Communications. Select another COM port from the list, then click OK. 

Press <Ctrl-Y> to force Dynamic C to recompile the BIOS. If Dynamic C still reports it 

is unable to locate the target system, repeat the above steps until you locate the COM 

port used by the programming cable.

• If you get an error message when you plugged the programming cable into a USB port, 

you will have to install USB drivers. Drivers for Windows XP are available in the 

Dynamic C Drivers\Rabbit USB Programming Cable\WinXP_2K folder — 

double-click DPInst.exe to install the USB drivers. Drivers for other operating sys-

tems are available online at www.ftdichip.com/Drivers/VCP.htm.
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If Dynamic C appears to compile the BIOS successfully, but you then receive a communi-

cation error message when you compile and load the sample program, it is possible that 

your PC cannot handle the higher program-loading baud rate. Try changing the maximum 

download rate to a slower baud rate as follows.

• Locate the Serial Options dialog in the Dynamic C Options > Project Options > 
Communications menu. Select a slower Max download baud rate.

If a program compiles and loads, but then loses target communication before you can 

begin debugging, it is possible that your PC cannot handle the default debugging baud 

rate. Try lowering the debugging baud rate as follows.

• Locate the Serial Options dialog in the Dynamic C Options > Project Options > 
Communications menu. Choose a lower debug baud rate.

2.5  Where Do I Go From Here?

If the sample program ran fine, you are now ready to go on to other sample programs and to 

develop your own applications. The source code for the sample programs is provided to allow 

you to modify them for your own use. The RCM3305/RCM3315 User’s Manual also 

provides complete hardware reference information and describes the software function calls 

for the RCM3305 and the RCM3315, the Prototyping Board, and the optional LCD/keypad 

module. The RCM3309/RCM3319 User’s Manual also provides complete hardware refer-

ence information and describes the software function calls for the RCM3309 and the 

RCM3319, the Prototyping Board, and the optional LCD/keypad module.

For advanced development topics, refer to the Dynamic C User’s Manual and the 

Dynamic C TCP/IP User’s Manual, also in the online documentation set.

2.5.1  Technical Support

NOTE: If you purchased your RCM3305 series module through a distributor or through a 

Rabbit partner, contact the distributor or partner first for technical support.

If there are any problems at this point:

• Use the Dynamic C Help menu to get further assistance with Dynamic C.

• Check the Rabbit Technical Bulletin Board and forums at www.rabbit.com/support/bb/ 

and at www.rabbit.com/forums/.

• Use the Technical Support e-mail form at www.rabbit.com/support/questionSubmit.shtml.
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3.  RUNNING SAMPLE PROGRAMS

To develop and debug programs for the RCM3305/RCM3315

(and for all other Rabbit hardware), you must install and use

Dynamic C.

3.1  Introduction

To help familiarize you with the RCM3305 and RCM3315 modules, Dynamic C includes 

several sample programs. Loading, executing and studying these programs will give you a 

solid hands-on overview of the RCM3305/RCM3315’s capabilities, as well as a quick 

start using Dynamic C as an application development tool.

NOTE: The sample programs assume that you have at least an elementary grasp of the C 

programming language. If you do not, see the introductory pages of the Dynamic C 

User’s Manual for a suggested reading list.

More complete information on Dynamic C is provided in the Dynamic C User’s Manual.

In order to run the sample programs discussed in this chapter and elsewhere in this manual,

1. Your RCM3305/RCM3315 must be plugged in to the Prototyping Board as described 

in Chapter 2, “Getting Started.”

2. Dynamic C must be installed and running on your PC.

3. The programming cable must connect the programming header on the RCM3305/

RCM3315 to your PC.

4. Power must be applied to the RCM3305/RCM3315 through the Prototyping Board.

Refer to Chapter 2, “Getting Started,” if you need further information on these steps.

To run a sample program, open it with the File menu, then press function key F9 to com-

pile and run the program. The RCM3305/RCM3315 must be in Program Mode (see 

Figure 8) and must be connected to a PC using the programming cable.
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3.2  Sample Programs

Of the many sample programs included with Dynamic C, several are specific to the 

RCM3305 and the RCM3315. Sample programs illustrating the general operation of the 

RCM3305/RCM3315, serial communication, and the serial flash are provided in the 

SAMPLES\RCM3300 folder. Each sample program has comments that describe the purpose 

and function of the program. Follow the instructions at the beginning of the sample pro-

gram. Note that the RCM3305/RCM3315 must be installed on the Prototyping Board 

when using the sample programs described in this chapter.

• CONTROLLED.c—Demonstrates use of the digital inputs by having you turn the LEDs 

on the Prototyping Board on or off from the STDIO window on your PC.

Once you compile and run CONTROLLED.C, the following display will appear in the 

Dynamic C STDIO window.

Press “2” or “3” or “4”or “5”on your keyboard to select LED DS3 or DS4 or DS5 or 

DS6 on the Prototyping Board. Then follow the prompt in the Dynamic C STDIO win-

dow to turn the LED on or off.

• FLASHLED.c—Demonstrates assembly-language program by flashing the USR LED 

on the RCM3305/RCM3315 and LEDs DS3, DS4, DS5, and DS6 on the Prototyping 

Board.

• SWRELAY.c—Demonstrates the relay-switching function call using the relay installed 

on the Prototyping Board through screw-terminal header J17.

• TOGGLESWITCH.c—Uses costatements to detect switches S2 and S3 using debounc-

ing. The corresponding LEDs (DS3 and DS4) will turn on or off.

Once you have loaded and executed these five programs and have an understanding of 

how Dynamic C and the RCM3305/RCM3315 modules interact, you can move on and try 

the other sample programs, or begin building your own.
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3.2.1  Use of Serial Flash

3.2.1.1  Onboard Serial Flash

The following sample programs can be found in the SAMPLES\RCM3300\SerialFlash 

folder.

• SFLASH_INSPECT.c—This program is a handy utility for inspecting the contents of a 

serial flash chip. When the sample program starts running, it attempts to initialize a 

serial flash chip on Serial Port B. Once a serial flash chip is found, the user can perform 

two different commands to either print out the contents of a specified page or clear (set 

to zero) all the bytes in a specified page.

• SFLASH_LOG.c—This program runs a simple Web server and stores a log of hits in 

the serial flash. This log can be viewed and cleared from a browser.

3.2.1.2  SF1000 Serial Flash Card

The following sample program can be found in the SAMPLES\RCM3300\SF1000 folder.

• SERFLASHTEST.c—An optional SF1000 Serial Flash card is required to run this dem-

onstration. Install the Serial Flash card into socket J11 on the Prototyping Board. This 

sample program demonstrates how to read and write from/to the Serial Flash card.

3.2.2  Serial Communication

The following sample programs can be found in the SAMPLES\RCM3300\SERIAL folder.

• FLOWCONTROL.C—This program demonstrates hardware flow control by configuring 

Serial Port F for CTS/RTS with serial data coming from TxE (Serial Port E) at 115,200 

bps. One character at a time is received and is displayed in the STDIO window.

To set up the Prototyping Board, you will need to tie 

TxE and RxE together on the RS-232 header at J14, 

and you will also tie TxF and RxF together as shown in 

the diagram.

A repeating triangular pattern should print out in the 

STDIO window. The program will periodically switch flow control on or off to demon-

strate the effect of no flow control.

• PARITY.C—This program demonstrates the use of parity modes by repeatedly sending 

byte values 0–127 from Serial Port E to Serial Port F. The program will switch between 

generating parity or not on Serial Port E. Serial Port F will always be checking parity, 

so parity errors should occur during every other sequence.

To set up the Prototyping Board, you will need to tie 

TxE and RxF together on the RS-232 header at J14 as 

shown in the diagram.

The Dynamic C STDIO window will display the error 

sequence.
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